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Chapter 1 Introduction

SL1100 PC Programming, referred to as PCPro, is an application used to manage the 
SL1100 system.  PCPro is rich with features to help users more easily manage a 
chassis when compared to handset programming.

The user can perform the following when using PCPro:

 Upload/Download settings between PCPro and a chassis.

 Save settings to files that can be archived for later use. 

 Program settings grouped by their relationship via standard screens. 

 Program settings sequentially via Wizards to complete a feature. 

 Generate reports that can be used to monitor settings.

 Automatically update chassis firmware remotely.

 Export settings to files for later use.

 Capture low level messages to problem solve through the Debug Terminal.
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Chapter 2 Installation

SECTION 1 SYSTEM REQUIREMENTS

The process of installing PCPro is straight-forward. Just run the installation program 
and follow the instructions. Table 2-1 System Requirements lists the minimum system 
requirements necessary for install PCPro on your computer.       

Table 2-1  System Requirements

CPU
Pentium® III 598 MHz (minimum)

Pentium 4 2.5 GHz (recommended)

Memory
128 MB of RAM

256 MB (recommended)

OS Windows XP, Vista, Windows 7 (32/64-bit)

Other Microsoft Internet Explorer 8.0 or higher

Communication port LAN, RS232 or Modem

Disk Space 25MB for PCPro (minimum)

TCP Port

PCPro must have TCP port 8000 open between the chassis and 
the host PC. Communications between PCPro and the chassis 
occurs on this port when uploading-downloading via LAN.

The PCPro TCP port is 8000 at default, but this can be changed 
through the Administration>WebPro Settings section of WebPro, 
or using PRG 90-54-02 in Web Pro, PCPro or Phone 
Programming.

TCP port 5963 is required to be open if the Debug Terminal is 
going to be used.
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SECTION 2 DEFAULT PCPRO ACCOUNTS

When installing PCPro for the first time, the installation program creates a set of 
default PCPro accounts. The accounts with the user name and password to access 
these accounts are provided in Table 2-2 Default PCPro Accounts.   

An install/uninstall does not remove or modify any existing PCPro Accounts, or 
Connection Accounts.

In addition, the installation program will create the following default folders:  

An install/uninstall does not result in the folder or any files in the folder being 
deleted.

Table 2-2  Default PCPro Accounts

User Name Password Access Level

sltech 12345678 Installer Mode (IN)

ADMIN1 0000 System Administrator Mode 1 (SA)

ADMIN2 9999 System Administrator Mode 2 (SB)

Table 2-3  Default Folders

Folder Name/Icon Location Description

My Databases <install dir>\databases
Default folder where PCPro databases 
are saved.

DebugTerm <install dir>\logfiles
Default folder where PCPro Debug 
Terminal log files are saved.

Reports <install dir>\reports
Default folder where PCPro reports are 
saved.

exports <install dir>\exports
Default folder where PCPro exported 
files are saved.
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SECTION 3 SOFTWARE INSTALLATION

The software can be installed from the application CD, provided with the chassis or 
downloaded from the web. 

1. Launch the installer.

If installing from a CD, the CD should autorun.  When the splash screen is 
displayed, select Install Software.

 If the software does not autorun, you can open the CD and select setup.exe.

If downloading from the website, copy the file to your computer and launch the 
installer.

2. When the installer launches, the InstallShield Wizard Welcome screen is 
displayed.  Press Next>.

If you do not want to continue, click Cancel to abort the installation and exit the 
software.

Figure 2-1  InstallShield Wizard Welcome Screen
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3. The next screen is displayed indicating the default location to install the PCPro 
files. 

If the default location is where you want the files located, click Next>.  Refer to 
Figure 2-2 InstallShield Wizard Destination Folder (Default Location).

If you want to change the location where the files are located, click Change.  
Refer to Figure 2-3 InstallShield Wizard Destination Folder (Change Location).

If you wish to return to the previous screen, click <Back.

If you do not want to continue, click Cancel to abort the installation and exit the 
software.

Figure 2-2  InstallShield Wizard Destination Folder (Default Location)
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Figure 2-3  InstallShield Wizard Destination Folder (Change Location)
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4. To install the program, click Install.

If you wish to return to the previous screen, click <Back.

If you do not want to continue, click Cancel to abort the installation and exit the 
software.

Figure 2-4  InstallShield Wizard Begin Installation
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5. The program installs.  Figure 2-5 InstallShield Wizard Installation Progress 
shows the screen you will see that indicates the progress of the installation.  

If you wish to return to the previous screen, click <Back.

If you do not want to continue, click Cancel to abort the installation and exit the 
software.

Figure 2-5  InstallShield Wizard Installation Progress
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6. When the installation is completed, Figure 2-6 InstallShield Wizard Finish 
Installation is displayed.  Click Finish. 

Figure 2-6  InstallShield Wizard Finish Installation
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SECTION 4 LAUNCHING THE APPLICATION SOFTWARE

Once the application software has successfully installed you can launch the 
application in one of two ways:
 Click the PCPro shortcut icon that was placed on your desktop during installation.  

   or....

 Select the program by clicking All Programs > SL1100 Application Suite > SL1100 
PCPro.  

Figure 2-7  SL1100 PCPro Desktop Shortcut

Figure 2-8  InstallShield Wizard Launch Software
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SECTION 5 LOGGING INTO THE APPLICATION

With PC Pro 3.50 or higher, the application comes up already logged in at the Installer 
level.  If there is a need to log in with a different level, the user can Log Off and Log In 
with a different user name and password.  Refer to Table 2-2 Default PCPro Accounts 
on page 2-2 for a list of default PCPro accounts and their associated user names and 
passwords. 

1. To Log Off, from the File menu, choose Log Off.  The Login window will come 
up.

2. Enter the appropriate User Name and Password and press OK.

If you do not want to continue, click Cancel to abort login and exit the software. 

Figure 2-9  PCPro Login Screen
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3. If the login is successful, the PCPro Welcome screen is displayed.  

Figure 2-10  PCPro Main Menu
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Chapter 3 Application Layout

SECTION 1 INTRODUCTION

The programming section of PCPro provides methods to view and edit values 
associated with a chassis configuration.  Most programming is done using three 
different views: Standard, Advanced and Wizards. These methods can be accessed 
through the menu item View.  Accessing these items updates the applications 
Submenu and Workspace areas. The Status bar gives a status indication of various 
functions related to PCPro (e.g., connection status, version information).

The general PCPro application layout is shown in Figure 3-1 PCPro Application 
Layout.

Figure 3-1  PCPro Application Layout

Menu

Ribbonbar

Submenu Status Bar Workspace

Sliding Bars
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SECTION 2 MENU

The menu displays the list of functions available in PCPro. Some of these commands 
have images next to them so you can quickly associate the command with the image. 

SECTION 3 TOOLBAR

The Toolbar is a group of buttons that map to items in the application menu. The 
toolbar allows for quick and convenient access to the most common PCPro 
commands. The items on the toolbar are shown in Figure 3-2 PCPro Toolbar. 

The keyboard shortcuts (where applicable) are listed below the toolbar 
identification in Figure 3-2 PCPro Toolbar.

  

The full list of the PCPro menu and toolbar hierarchy is found in Chapter 7 - Menu and 
Toolbar Reference.

SECTION 4 SUBMENU AREA

The Submenu Area is used to navigate through Hardware Settings, Standard View 
(refer to Chapter 4 - Standard View), Wizards (refer to Chapter 5 - Wizards View) and 
Advanced View (refer to Chapter 6 Advanced View on page 6-1).  Selections made 
from the submenu area updates the workspace with the related settings.

Figure 3-2  PCPro Toolbar



NEC SL1100 Issue 3.01

PC Programming Manual 3 - 3

___________________________________________________________________________________

___________________________________________________________________________________

SECTION 5 WORKSPACE

The Workspace is where all programming occurs. The Workspace consists of various 
selections made from the Submenu Area and the Workspace itself. Common 
Workspace components are further explained.  

Figure 3-3  PCPro Workspace

Title Subtitle
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Buttons

Data Area
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Help Area
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5.1 Title

Title describes what the current settings in the Workspace are related to. This 
is associated with the selection made in the Submenu Area. The title is 
situated at the top left corner of the Workspace.

5.2 Subtitle

Subtitle shows further information about what the you are programming.

5.3 Workspace Buttons

The Workspace buttons area displays different buttons relevant to current 
programming. These buttons include:   

Table 3-1  Workspace Buttons

Button Description

Apply sets changes recently made on the active screen. Attempting to 
apply an invalid value prompts a validation message detailing the 
error.  In this case, changes are not applied until the value is made 
valid.

Back returns to the previous screen for the specified feature.  This 
button is only available when using Wizards.  

Cancel discards recent changes made to the active screen that have 
not been applied and displays the Home screen in the Workspace.

Copy shows the Copy dialog.  Refer to Appendix B - Copy/Fill for more 
information.

Default resets the active screen to the system default values.

Finish indicates that this is the only program for this feature.  Once 
you have entered the information for the program, you are finished 
programming the feature.
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When you do not click the Apply button, but do one of the following, the 
system applies the changes as if you had clicked the Apply button.

 Attempt to leave the current screen.

 Attempt to navigate a different item within the system data.

 Use the Previous button.

 Use the Next button.

 Save the active configuration.

 Exit the application.  (Note that on some screens, the system prompts you 
to save the changes or to exit without saving them.)

 Generate a report.

Form View is available on screens that have a large number of values 
that must be entered (e.g., screens with telephone extensions).  When 
Form View is selected, the screen switches to a table format, allowing 
you to more easily enter a large number of values for a specified 
extension.  

For example, if assigning your incoming virtual ring tones for internal 
extensions, you can switch from Grid View to Form View to list all of  
the extensions in table format.  

Note that this option is not available on all screens.

Grid View is available on screens that have a large number of values 
that must be entered (e.g., screens with telephone extensions).  When 
Grid View is selected, the screen switches to the default view, which 
displays the values with pulldown boxes.   

For example, if assigning you incoming virtual ring tones for internal 
extensions, you can switch between Grid View to Form View. 

Note that this option is not available on all screens.

Next proceeds to the next screen for the feature.  When all of the 
programs have been displayed for the selected feature, pressing Next 
returns you to the Main screen.  This button is only available when 
using Wizards. 

Table 3-1  Workspace Buttons

Button Description
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5.4 Navigation Area

To navigate to different items within a program, use the various navigation 
buttons.  

 

Figure 3-4  PCPro Navigation Buttons

Table 3-2  Navigational Buttons and Drop Down List

Button/Menu Description

Selections Select the item from the drop down list. PCPro 
automatically moves to the selected item.

Ranges Use this button to select a range of values.  Type in the 
value and press the ‘Go’ button (magnifying glass icon) or 
press Enter.  PCPro displays a range of available items, 
beginning with the value you typed.  For example, if you 
typed Station Port 300, PCPro displays a range of ports 
beginning with port 300.

Previous/Next Use Previous to show settings of the preceding item.

Use Next to show settings of the next item.

Select an item to view

Move to the previous item

Move to the next item

Navigation Filters

Move to specified items
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5.5 Data Area

The Data Area is where actual system data appears. The contents of this area 
are specific to what the you are programming. For example, if programming 
PRG 10-02, this area shows all the data items within 10-02.

The contents of the Data Area are linked to the various system data views 
available. These are:

 Standard

 Wizards

 System Data

5.6 Help Area

The Help Area shows help text relevant for the data in the Data Area. More 
extensive help can usually be found in the application online help (F1 key).

5.7 Status Bar

The status bar, which is a horizontal area at the bottom of the Workspace, 
provides information about the current state of what you are viewing in the 
Workspace and any other contextual information.    

Figure 3-5  PCPro Status Bar
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Chapter 4 Standard View

SECTION 1 OVERVIEW

Standard View combines related settings into one screen, allowing a quick setup of a 
high level task. Settings on these screens work together, allowing you to understand 
how settings relate to each other. Standard screens are grouped into System, 
Stations, Lines, InMail, and Maintenance. This name indicates the tasks with which 
the screen is related. 

Figure 4-1  Standard View Submenu

Auto Hide: Clicking this icon 
hides the Standard submenu 
list and docks the tabs on the 
left side of the screen.

Close: Clicking this icon 
closes the Standard submenu 
list and tabs. 
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SECTION 2 STANDARD VIEW SUBMENU

2.1 Accessing Standard View

You can access Standard View submenu area using any of the following 
methods: 

 From the Standard View submenu, select the Ribbon Item 
View> Standard.

    or…

 Press F9.

   or…

 If the submenu area is currently open, select the Standard tab depicting 
the purple cog icon.  

Once selected, the Standard View menu appears in the Programming 
submenu area.

To view a particular Standard View screen, click on the screen name.  

Figure 4-2  Selecting a Standard View Screen

Standard View selection
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2.2 Using a Standard View Screen

Each Standard View screen contains different programming items. However, 
the following common methods apply:

1. Select the Standard View screen from the Standard View menu relevant 
to the desired task.

2. Modify settings on the screen.

3. Press the Apply button to save the changes.

The method in modifying settings for each screen is explained in the help 
menu.

The remainder of this chapter discusses the individual options available from 
the Standard View submenu.  

SECTION 3 SYSTEM

The System section of the Standard View is used to define the most common system 
wide settings in the SL1100.  The System section consists of Config, Options, Blades/
Ports, Numbering, Dialing Rules, Class of Service, Timers, Speed Dials, VOIP, 
VoiceMail, SLNet, ACD, and Hotel/Motel settings.  Each of these subsections will be 
displayed later in this section.
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3.1 Config

Installation Information - define the Installation Date and the SMTP name for 
when alarm reports are e-mailed. (ex: smtp.your-isp.com)  

Figure 4-3  Installation Information Screen
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Time&Date   

1. Define the Date and Time by clicking the time settings button.  You must 
be connected to the system for this button to be active.

2. Define the Time Zone for the CPU.

3. Select if the system will follow Daylight Savings time.

4. If they system is to get it’s time using Network Time Protocol, enable it 
and define the IP address of the NTP Server.

Figure 4-4  Time and Date 
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Connection      

Figure 4-5  Connection Screen

Figure 4-6  Connection Settings
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1.  If the SL1100 is to get it’s IP Address via DHCP, enable it by checking 
DHCP Client Mode.

2. If the SL1100 is to have a static IP address, define the IP Address, 
Subnet Mask, VoIPDB IP Address, VOIPDB Subnet Mask, Default 
Gateway, NAPT Router, and NAPT Router IP Address.

3. When alarm reports are to be emailed, Define the DNS Primary and 
Secondary addresses.

4. Define the DNS Primary and Secondary addresses for FTP Firmware 
Update.

5. Define the NetBIOS Settings

6. If the PC Pro and Webpro ports need to be changed, change them in 
PC/Web Programming Settings.

7. Define the VLAN Setup for the CPU port and VOIPDB Port.

E-Mail Settings   

1. Define the SMTP settings, if InMail SMTP e-mail notification is used.

2. Define the POP3 settings if InMail POP3 e-mail notification is used.

Figure 4-7  E-Mail Settings
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3. Define the Alarm Report SMTP Settings if Alarm Reports are to be 
emailed.

Audio Ports & Relays   

1. Define the source for Background Music and External Music on Hold.

2. Define the Relay Port Settings

3. Define the Music on Hold Settings

Figure 4-8  Audio Ports and Relays
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Passwords  

1. If needed, edit or add Administrator Programming Passwords.

Figure 4-9  Passwords Screen
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Tones   

1. Define the ring cycle for each of the ring tones.

Figure 4-10  Tones Screen
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3.2 Options

Setup   

1. Enable or Disable pre-ringing for trunk calls. 

2. Define the Multi-Line Telephone Options

3. Define the Operator’s Extension(s)

4. Define the Transfer System Options

5. Define the Caller ID System Options

Figure 4-11  Options Setup Screen



4 - 12 Standard View

___________________________________________________________________________________

___________________________________________________________________________________Issue 3.01 NEC SL1100

Conference  

1. Define the Conference Group Setup.

Figure 4-12  Conference Screen
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Night Mode   

1. Define the Night Mode Switching Setup.

2. Define the operation of the Night Mode Key. 

Figure 4-13  Night Mode Switching Screen
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1. Define the Time Patterns for Automatic Night Service.

Figure 4-14  Night Mode Screen (continued)
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1. Define the time pattern each Night Mode Service group will follow an 
each day of the week.

Figure 4-15  Time Pattern Settings
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1. Define the Night Mode Name for each Night Mode Service Group.

2. Define the Night Mode the Toggle key toggles between.

Figure 4-16  Weekly Night Mode Settings
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Paging  

1. Define the Internal and External Paging Options

2. Assign an External Paging Group to an Internal Paging Zone for 
Combined Paging.

3. Define the Background Music option for each External Paging Zone.

4. Define the External Paging Zone Group names.

Figure 4-17  Paging
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1. Assign names to Internal Paging Groups.

Figure 4-18  Internal Paging Group Setting
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1. Assign each External Paging zone to an External Paging group.

Figure 4-19  External Paging Groups



4 - 20 Standard View

___________________________________________________________________________________

___________________________________________________________________________________Issue 3.01 NEC SL1100

1. Assign Universal Night Answer ringing to each external Paging Zone.

Figure 4-20  Universal Night Answer



NEC SL1100 Issue 3.01

PC Programming Manual 4 - 21

___________________________________________________________________________________

___________________________________________________________________________________

1. Define the settings for the external speaker using an amplifier.

Figure 4-21  External Speaker Settings 
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SMDR  

1. Define the TCP Port and KeepAlive Time for SMDR Output.

2. Define the SMDR Port Type and Header Language.

Figure 4-22  SMDR Screen
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3.3 Blades/Ports

The screen represents a conceptual model of the chassis and the blade 
packages within it. To obtain blade details download the configuration from the 
chassis. The blade slots display the blade types (these are the blades that can 
be inserted in the selected slot), the telephone/trunk port range (these are the 
ports used by the blade) and firmware version (firmware being used by the 
blade).

On this screen, you can right mouse click on the desired slot. A popup menu is 
displayed indicating the configurable options for that slot. Once you have 
selected the blade that is installed in that slot, the blade name is displayed on 
the front of the slot location.  

Figure 4-23  Blades/Ports
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3.3.1 Adding a Blade

To add a blade, complete the following steps:

1. With the mouse, right click on the slot where you want the blade 

to reside.

2. A popup menu appears listing the blade types that can be 
installed. There are two additional options on the popup menu. 
These are Configure Card and Delete Card. Note that these two 
options are only available if a blade has previously been added.

3. Select a blade type relevant to the blade to install.

4. Another popup menu appears listing blades associated with the 
selected blade type.

5. Select the desired blade package you want to add. The slot 
changes appearances indicating the blade installed, the firmware 
version being used, the port type, and the port range being used.

3.3.2 Removing a Blade

To remove a blade, complete the following steps:

1. With the mouse, right click on the blade you want to remove.

2. When the popup menu is displayed, select Delete Card. The 
blade is removed and the slot and port type range it was utilizing 
is now available for use by another blade.



NEC SL1100 Issue 3.01

PC Programming Manual 4 - 25

___________________________________________________________________________________

___________________________________________________________________________________

3.4 Numbering

Numbering Plan-System Numbering  

Define the digit length and Dial type for each digit.  If the Numbering Plan will 
be broken out past the 1st digit, set the dial type to Dial Extension Analyze.

Figure 4-24  Numbering Plan - System Numbering
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Numbering Plan-Extension Dial Analyze  

If the Numbing Plan is broken out past the 1st digit, define the Dial Digits and 
their dial type.

Figure 4-25  Numbering Plan - Extension Dial Analysis
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Stations  

Assign extension numbers to station ports.

Figure 4-26  Stations Screen 
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Virtual Extensions  

Assign extension numbers to Virtual Extension ports.

Figure 4-27  Virtual Extensions
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Department Groups  

Assign Pilot numbers to each Department Group

Figure 4-28  Department Groups 
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Busy Actions  

Assign the 1-Digit Service Codes.

Figure 4-29  Busy Actions
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Other  

Assign the Trunk Access Code, ACD Pilot Numbers, and Conference Group 
Pilot Numbers.

Figure 4-30  Other Settings
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Service Codes  

Assign the Service Codes for the System Administrator.

Figure 4-31  Service Codes
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3.5 Dialing Rules

Analysis-Table  

Assign the Dial Digits, Service Type, Additional Data, and Dial Tone 
Simulation.

Figure 4-32  Analysis-Table 
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Analysis-Extended Table  

When the dial digits are more than eight digits, define the dial digits and the 
F-Route Table.

Figure 4-33  Analysis - Extended Table



NEC SL1100 Issue 3.01

PC Programming Manual 4 - 35

___________________________________________________________________________________

___________________________________________________________________________________

Analysis-Extended Table Entry 251  

If the received digits do not match the digits set in table 1-250, the F-Route 
table number defined in table 251 is used.

Figure 4-34  Analysis-Extended Table Entry 251
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Analysis-Extended Table Entry 252  

If the received digits do not match the digits set in tables 1-250, table number 
252 is used to refer to the next Extension Table Area (1-4).

Figure 4-35  Analysis-Extended Table Entry 252
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Routing-Table 

Define the additional conditions for each F-Route Table.

Figure 4-36  F-Routing Table
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Routing-Additional Dial Table 

Define digits to be dialed prior to the dialed F-Route Number.

Figure 4-37  Routing-Additional Dial Table
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3.6 Class of Service

Administration  

Define the Administrator service availability for each extension Class of 
Service (COS).

Figure 4-38  COS Administration Screen



4 - 40 Standard View

___________________________________________________________________________________

___________________________________________________________________________________Issue 3.01 NEC SL1100

Call Answer 

Define the answer feature availability for each extension Class of Service 
(COS).

Figure 4-39  Call Answer
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Features 

Define the supplementary feature availability for each extension Class of 
Service (COS).

Figure 4-40  Features Screen
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Hold/Transfer 

Define the Hold and Transfer feature availability for each extension Class of 
Service (COS).

Figure 4-41  Hold/Transfer
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Hotel/Motel 

Define the Hotel/Motel feature availability for each extension Class of Service 
(COS).

Figure 4-42  Hotel/Motel
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Incoming  

Define the incoming call feature availability for each extension Class of 
Service (COS).

Figure 4-43  Incoming 
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Outgoing 

Define the outgoing call feature availability for each extension Class of Service 
(COS).

Figure 4-44  Outgoing 
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3.7 Timers

COI  

Define the basic timers for the COIU.

Figure 4-45  COI Timers 
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Doorphone 

Define the timers used for the Door Box.

Figure 4-46  Door Box Timers
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Features  

Define the basic System, MultiLine Telephone, and Virtual Extension timers.

Figure 4-47  Features Timers
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Hold  

Define the basic system timers for the Hold feature.

Figure 4-48  Hold Timers 
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Incoming  

Define the basic system timers for Incoming Calls.

Figure 4-49  Incoming Calls Timers
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Outgoing  

Define the basic system timers for Outgoing Calls.

Figure 4-50  Outgoing Calls Timers 
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Transfer  

Define the basic system timers for the Transfer feature.

Figure 4-51  Transfer Timer
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3.8 Speed Dials

Setup  

Define the Speed Dial functions.

Figure 4-52  Setup Speed Dial Functions 
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Groups  

Define the range of bin numbers to be used by each Speed Dialing group.

Figure 4-53  Bin Numbers
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Assignments  

Define the Speed Dial Numbers and Names and the Trunk Group/Route to be 
used.

Figure 4-54  Assigning Speed Dial Features
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3.9 VOIP

IP Keysets- Basic Setup  

Define the Basic Setup for IP Keysets.

Figure 4-55  IP Keysets - Basic Setup 
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IP Keysets- Logon Information  

Define the Logon Information used when Automatic or Manual registration is 
used.

Figure 4-56  IP Keysets - Logon Information 
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IP Keysets-Codec Setup (Basic) 

Define the CODEC of each type of DR700 Multiline Telephone.

Figure 4-57  IP Keysets - Codec Setup (Basic)
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Setup-ToS  

Define the ToS Setup.

Figure 4-58  Setup - Type of Service (ToS)
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Setup-VOIPDB  

Define the IP Address, Port, and DTMF type for the VOIPDB.

Figure 4-59  Setup - VOIPDB
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SIP Stations-Basic Setup  

Define the System Operation, Registrar/Proxy, Server Information, and 
Intranet Setup for SIP Stations.

Figure 4-60  SIP Stations - Basic Setup
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SIP Stations-Codec Setup (Basic)  

Define the CODEC information for SIP Stations.

Figure 4-61  SIP Stations - Codec Setup (Basic)
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SIP Trunks-Basic Setup

Define the basic setup for SIP trunks.

Figure 4-62  SIP Trunks - Basic Setup
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SIP Trunks- Codec Setup (Basic)  

Define the basic CODEC options for SIP trunks.

Figure 4-63  SIP Trunks - Codec Setup (Basic)
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SIP Trunks- IP System Interconnect  

Define the IP Addresses, call control port numbers, and Dial Numbers for 
other systems that are interconnected.

Figure 4-64  SIP Trunks - IP System Interconnect
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SIP Trunks - Registration Information  

Define the SIP Trunk registration information.

Figure 4-65  SIP Trunks - Registration Information
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SLNet  

Define the SL Networking CODEC Information.

Figure 4-66  SL Networking Codec Information
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3.10 VoiceMail

Setup  

Customize the Voice Mail Integration Options.

Figure 4-67  VoiceMail Setup Screen
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3.11 SLNet

Setup  

Define the Networking System IP Addresses, Keep Alive Setup, and BLF 
Refresh Interval.

Figure 4-68  SL Networking Setup
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3.12 ACD

Setup-Basic Setup  

Define the Queue Message Repeat Time, and ACD Weekly Schedule Setup.

Figure 4-69  ACD Basic Setup
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Setup-Time Pattern  

Define the ACD Time Patterns for Agents and Trunks.

Figure 4-70  ACD Time Pattern Setup
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Group Setup  

Define the ACD Overflow Options, Overflow Tables, Delay Announcement 
VRS Settings, Night Announcement Options, Night Announcement VRS 
Settings, ACD Group Options, ACD Queue Threshold Settings, Delay 
Announcement Voice Mail Settings, and ACD Queue Display Settings.

Figure 4-71  ACD Group Setup
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3.13 Hotel/Motel

Codes  

Define the Hotel/Motel one digit service codes.

Figure 4-72  Hotel/Motel - Codes
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Setup  

Define the Hotel/Motel System Options and Hotel Room Status Output.

SECTION 4 STATIONS

The Stations section of the Standard View is used to define the most common station 
settings in the SL1100.  The Station section consists of Config, Doorphones, 
Department Groups, DSS, and Text Messages settings.  Each of these subsections 
will be displayed later in this section.

Figure 4-73  Hotel/Motel - Setup
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4.1 Config

Setup     

Figure 4-74  Stations - Configuration Setup
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Figure 4-75  Stations - Configuration Setup (continued)
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Figure 4-76  Stations - Configuration Setup (continued)
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Figure 4-77  Stations - Configuration Setup (continued)
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Define the Night Mode Group Assignment, Extension Basic Setup, Multi-Line 
Telephone Setup, Incoming Virtual Extension Ring Tone Setup and Order, 
Virtual Extension Key Enhanced Options, Mobile Extension Setup, Class of 
Service, Trunk Group Routing, Tool Restriction Class, Hotline Assignment, 
ISDN Calling Party Number, IP Trunk (SIP) Calling Party Number, Ringing 
Line Preference, Call Forwarding Fixed Settings, ARS Class of Service, 
Internal Paging Group Assignment, ACD Group Assignment, Hotel/Motel 
Setup, and Users Programming Password for each extension.

Figure 4-78  Stations - Configuration Setup (continued)
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Ring Tone  

Define the extensions trunk incoming ring tone for each mode.

Figure 4-79  Stations - Ring Tone
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Groups 

Define the Department Group Assignment, Call Pickup Group, and Internal 
Paging Group for each extension.

Figure 4-80  Stations - Groups
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Keys-Function   

Figure 4-81  Stations - Function Keys
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Define the Function Key Assignment for each extension.  Clicking the 
Function Key button brings up the Function Key Assignment Window.  Select 
the Key type in the left drop down box and define the additional data in the 
right drop down box.  Once defined, click the key to apply this setting to.

Figure 4-82  Stations - Function Keys (continued)
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Keys-Ring  

Define the ring options for an extension’s Virtual Extension Keys.  This must 
be defined for each Night Service Mode.

Figure 4-83  Stations - Ring Options
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Keys-Delay Ring 

Define the delay ring options for an extension’s Virtual Extension Keys.  This 
must be defined for each Night Service Mode.

Figure 4-84  Stations - Delay Ring
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Keys-Loop Assignments  

Define the Loop Key Assignment for each extension.

Figure 4-85  Stations - Loop Key Assignments



NEC SL1100 Issue 3.01

PC Programming Manual 4 - 87

___________________________________________________________________________________

___________________________________________________________________________________

Speed Dials  

Assign extensions to a Speed Dial Group and define the dial number and 
name for each speed dial number.

Figure 4-86  Stations - Speed Dial Group
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InMail 

Define the InMail Station Mailbox Options.

Figure 4-87  Stations - InMail
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VoIP 

Define the basic settings for IP Telephones.

Figure 4-88  Stations - VoIP
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4.2 Doorphones

Setup  

Assign the extensions that ring when the associated Door Box button is 
pressed.

Figure 4-89  Doorphones - Ring Assignment
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4.3 Department Groups

Setup  

Define Department Group Basic options, Assign extensions second 
Department Group, and set Department group calling restriction.

Figure 4-90  Department Groups - Setup
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InMail   

Figure 4-91  Department Groups - InMail 
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Figure 4-92  Department Groups - InMail (continued)
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Define InMail Group Mailbox Options, Group Mailbox Subscriber Options, 
Group Mailbox Message Notification Options, and Group Mailbox Find-Me 
Follow-Me Options.

Figure 4-93  Department Groups - InMail (continued)



NEC SL1100 Issue 3.01

PC Programming Manual 4 - 95

___________________________________________________________________________________

___________________________________________________________________________________

4.4 DSS

Setup 

Define DSS Console Operation Mode and Extension Assignment.

Figure 4-94  DSS - Setup
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Key Assignment  

Assign Function Keys to DSS Console Keys.

Figure 4-95  DSS Console Key Assignment
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4.5 Text Messages

Setup  

Define the Selectable Display Messages up to 24 characters each.

Figure 4-96  Text Messages - Setup
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SECTION 5 LINES

The Lines section of the Standard View is used to define the most common trunk 
related settings in the SL1100.  The Lines section consists of Config, Access, 
Incoming, Toll Restriction, Account Codes, and ARS settings.  Each of these 
subsections will be displayed later in this section.

5.1 Config

Setup    

Figure 4-97  Lines - Configuration Setup
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Figure 4-98  Lines - Configuration Setup (continued)
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Figure 4-99  Lines - Configuration Setup (continued)
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Define the Night Mode Group Assignment for Trunks, Trunk Basic Setup, 
Trunk Groups, Music on Hold Source for Trunks, Trunk Group Routing for 
Trunks, ISDN Calling Party Number for Trunks, Toll Restriction Class of 
Trunks, Incoming Call Trunk Setup, Trunk Ring Tone Setup, Incoming Trunk 
Ring Group Assignment, DIL Assignment, DIL/IRG No Answer Destination, 
Automatic Trunk to Truck Transfer Target Setup, and DUD/DISA Transfer 
Target.

Figure 4-100  Lines - Configuration Setup (continued)
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E&M 

Define the basic settings for each E&M Tie Line.

Figure 4-101  Lines - E&M Tie Line
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InMail  

Define the InMail options for each trunk.

Figure 4-102  Lines - InMail
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5.2 Access

Groups  

Define an trunk group order for each routing table.

Figure 4-103  Access - Groups
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Maps  

Define the trunk access for each Access Map.

Figure 4-104  Access - Maps
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5.3 Incoming

Setup-Private Call   

Define Speed Dial group number for Private Call Refuse and the assignment 
and incoming ring pattern for Private Calls.

Figure 4-105  Setup - Private Call
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Setup-Assignment for ACD Group   

Define the Incoming Ring Group Assignment for ACD Groups.

Figure 4-106  Setup - Assignment for ACD Group
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Ring Groups   

Assign Extensions to Incoming Ring Groups.

Figure 4-107  Ring Groups
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DID-Trunk Groups  

Define the basic settings of Dial-In incoming calls for each trunk group.

Figure 4-108  DID - Trunk Groups
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DID-Area Setup  

Define the size of the DID Translation Tables.  There are 2000 Translation 
Table Entries that can be allocated among 20 Translation Tables.

Figure 4-109  DID - Area Setup
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DID-Table Setup   

Define the properties of each DID Translation Table entry.

Figure 4-110  DID Table Setup
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5.4 Toll Restriction

Setup   

Set the system Toll Restriction classes.

Figure 4-111  Toll Restriction
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PBX Access Codes 

Define the Trunk Access Code for Behind PBX Lines.

Figure 4-112  PBX Access Codes
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Common   

Define the Common Permit Codes and Common Restrict Codes.

Figure 4-113  Common Codes
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Maximum Digits Table   

Define the maximum number of digits allowed in outgoing calls for each table.

Figure 4-114  Maximum Digits Table
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Permit Codes   

Define the Permit Code Tables.

Figure 4-115  Permit Codes
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Restrict Codes   

Define the Restrict Code Tables.

Figure 4-116  Restrict Codes
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International   

Define the Restrict and Permit tables for International calls.

Figure 4-117  Restrict - International Calls
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5.5 Account Codes

Setup   

Define Account Code Options for each Class of Service.

Figure 4-118  Account Code - Setup
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Table   

Define Verified Account Codes.

Figure 4-119  Verified Account Code Table
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5.6 ARS 

Analysis   

Define pre-transaction tables for selecting Automatic Route Selection (ARS/F-
Route).

Figure 4-120  ARS Analysis
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Setup   

Define the system options for Automatic Route Selection (ARS/F-Route)

Figure 4-121  ARS - Setup
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Treatments   

Define the 15 Dial Treatments for automatic ARS dialing translation.

SECTION 6 INMAIL

Figure 4-122  Dial Treatments - ARS
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6.1 Config

Setup  

Define the InMail system-wide options.

Figure 4-123  InMail Setup - Config
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6.2 Answer Table

Setup   

Define the options for the Answer Tables. InMail provides eight Answer Tables 
(1 ~ 8). To set up the schedules for each Answer Table, go to 47-12 : InMail 
Answer Table Schedule.

Figure 4-124  InMail Answer Table Setup
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Schedules   

Define the InMail Automated Attendant Answer Schedules. There are eight 
Answer Tables, with up to 10 Answer Schedules in each Answer Table.

Figure 4-125  Schedules



NEC SL1100 Issue 3.01

PC Programming Manual 4 - 127

___________________________________________________________________________________

___________________________________________________________________________________

6.3 Call Routing

Setup   

Define the 32 Routing Mailboxes. Routing Mailboxes can be either 
Announcement or Call Routing Mailboxes.

Figure 4-126  Call Routing Setup
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Directory   

Define the Routing Directory Mailbox Options. This data is referred if Program 
47-07-02 (Routing Master Mailbox Type) was set to Type 4 (Directory).

Figure 4-127  Directory
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Distribution   

Define the Routing Mailbox Distribution Options.

Figure 4-128  Routing Mailbox Distribution Options
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Routing   

Define the options for Mailboxes assigned as Routing and Announcement 
boxes.

Figure 4-129  Routing
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6.4 Dial Actions

Setup   

Define the InMail Dial Action Tables. The Dial Action Table defines the options 
than an Automated Attendant caller can dial. A Dial Action Table is associated 
with a Call Routing Mailbox, which is in turn associated with an Answer Table. 
When an Answer Table is active, its associated Call Routing Mailbox selects 
the Dial Action Table which provides dialing options to callers.

SECTION 7 MAINTENANCE 

Figure 4-130  InMail Dial Actions Setup



4 - 132 Standard View

___________________________________________________________________________________

___________________________________________________________________________________Issue 3.01 NEC SL1100

7.1 Alarms

Options   

Define the System Alarm Output Port, Alarm Report SMTP Settings, Alarm 
Report CC Mail Setup, and System Alarm Setup.

Figure 4-131  Alarms - Options
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Display   

Define the Display Telephone for each Alarm Index.

Figure 4-132  Display
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7.2 System 

Licensing   

Enable the Free License and view how many days the Free License remains 
active.

Figure 4-133  System Licensing
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Software   

View the Main Software Information, Firmware Information, Firmware Update 
Time Setting, and define the FTP Firmware Update information.

Figure 4-134  Software
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-- NOTES --



PC Programming Manual 5 - 1

___________________________________________________________________________________

Chapter 5 Wizards View

SECTION 1 OVERVIEW

Wizards chronologically group System Data, guiding users in the successful setup of 
a  feature. Wizards are identified by their name. This name indicates the feature to 
which the Wizard is related.

With PC Pro 3.50 and higher, the Wizard View is not displayed at default.  To access 
the Wizard View, refer to Section 2 Accessing Wizard View.

Wizard System Data is grouped by screens. Complete each screen in a Wizard to 
complete a feature.   

Figure 5-1  Wizard Submenu

Auto Hide: Clicking this icon 
hides the Wizard submenu list 
and docks the tabs on the left 
side of the screen.

Close: Clicking this icon 
closes the Wizard submenu 
list and tabs. 
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SECTION 2 ACCESSING WIZARD VIEW

To access Wizard View complete one of the following:

 Select the menu item View > Wizards.

    or…

 Press F12.

or…

 If the Wizard submenu area is currently open, select the Wizard tab depicting 
the magic wand, located at the bottom on the submenu.  

The Wizard View Menu appears in the submenu area. Wizards are ordered 
alphabetically.   Refer to Figure 5-1 Wizard Submenu.  You can use the Expand All to 
view all of the items under each letter of the alphabet or Collapse All to return to 
letters of the alphabetic listing.  You can individually expand or collapse a letter of the 
alphabet by pressing or .  

SECTION 3 SEARCHING FOR A FEATURE

You can use the search function of the Wizard to locate a specific feature or use a 
keyword to find a group of related features. The example below shows entering the 
exact feature name to locate the feature and entering a keyword to locate a group of 
similar features.  Start the search by either pressing the magnifying glass icon or 
pressing Enter.   
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SECTION 4 PROGRAMMING LEVELS

There are three levels in which feature programming is grouped.  You can apply 
program filters to system data programming: 

 Level 1 – are the most commonly assigned programs for a feature.

 Level 2 – are the next most commonly assigned programs for a feature.

 Level 3 – are programs that are not often assigned for a particular feature and 
require an expert level working knowledge of the system to be properly 
assigned.  

To show the level of programming for a feature:

1. Press the desired level to view the programs assigned at that level.

2. Select a feature.  

Level 1 Level 2 Level 3
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SECTION 5 USING WIZARDS

When you select a feature from the Wizard list the associated screen is displayed, 
allowing you to program the feature.  If there is more than one screen that is 
programmed for the feature, you can use the Next and Back navigational buttons to 
switch between screens or you can use the View page in wizard pulldown menu. 

Figure 5-2  Wizard Programming

Wizard Name View Page in Wizard Program Navigational 
Buttons

Operational 
Buttons

1) Select a 
Wizard.

2) Program 
system data.

3) Change the Wizard page by selecting the page from the 
pulldown menu or pressing either the Next or Back 
navigational buttons.
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To use a Wizard to program a feature:

1. Select the feature Wizard from the Wizard View submenu.

2. Modify the desired settings on the screen.

3. Navigate to the next screen in the Wizard by either selecting the desired page 
from the View page in wizard or by pressing the Next or Back navigational 
buttons.

4. Complete steps 2 and 3 until all screens are finished.

5. Apply the changes.

When programming a Wizard, changes to system data are applied:

 when you press the Apply button.

 when you move to a different page in the Wizard.

 when you exit the Wizard, except in the case when the Cancel button is pressed.

The Cancel button only discards changes made on the current screen. It will not 
undo all changes made in the Wizard.
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-- NOTES --
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Chapter 6 Advanced View

SECTION 1 OVERVIEW

The Advanced view can be used to program system data by PRG. System Data 
represents system settings as per the categorization used by main software. This 
categorization separates settings into System Data items called ‘PRGs’ (programs). 
PRGs are identified by their ID and name. The ID and name indicate what settings the 
System Data is related to. An example of a PRG identifier can be seen below, ‘10-02’ 
is the ID and ‘Location Setup’ is the name:

10-02: Location Setup

PRGs are grouped by their relationship into ‘PRG Groups’. PRG Groups are identified 
by their ID and name. The ID and Name indicate what settings the System Data is 
related to. An example of a PRG identifier can be seen below, ‘10-XX’ is the ID and 
‘System Configuration’ is the name:

10-XX: System Configuration

Since Advanced View Programming does not group together the programs for a 
function/feature as with Wizards and Standard screens, Advanced View Programming 
is intended for advanced users of PCPro who are very familiar with programming a 
system. 
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Figure 6-1  Advanced View Submenu

Auto Hide: Clicking this icon 
hides the System Data 
submenu list and docks the 
tabs on the left side of the 
screen.

Close: Clicking this icon 
closes the System Data 
submenu list and tabs. 
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SECTION 2 ACCESSING ADVANCED VIEW

To access Advanced View, complete one of the following:

 Select the menu item View > Advanced.

    or…

 Press F11.

    or…

 If the Advanced submenu area is currently open, select the Advanced tab 
depicting the blue box, located at the bottom on the submenu.    

The Advanced View Menu appears in the submenu area. System Data is grouped by 
PRG Groups and ordered numerically by ID.  You can use the Expand All to view all of 
the items under each Program Number or Collapse All to return to the numeric 
program listing.  You can individually expand or collapse a program number pressing 

or .  
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SECTION 3 SEARCHING FOR A PROGRAM

You can use the search function of Advanced View to locate a specific program or use 
a keyword to find a group of related programs. The example below shows entering a 
program number to locate a specific program and entering a keyword to locate a 
group of similar programs.  Start the search by either pressing the magnifying glass 
icon or pressing Enter.   
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SECTION 4 ADVANCED VIEW PROGRAM FILTERING

When selecting programs from the system data list, you can select from the following 
filters:

  – shows all system data.

  – shows only unsaved system data.

  – show only system data that needs to be uploaded.

  – shows only system data that is unsaved and needs to be uploaded.

To show the level of programming for a feature:

1. Select a program.

2. Press the desired filter and view the filtered programs.  

Filter 2 Filter 3 Filter 4Filter 1
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SECTION 5 USING ADVANCED VIEW

System Data screens are intended for advanced users who are very familiar with 
using PCPro.  If you are not familiar with PCPro, you should use either the Standard 
View or Wizards.  Standard View and Wizards are grouped together to help walk you 
through system data necessary for programming various features of the system. 

Figure 6-2  System Data Programming

Pull down menu to 
changed system data 
item being viewed. 

View Previous 
item. 

View Next 
item. 

Filter

Mouse over for 
help information.

2)  Modify system 
data items.

1)  Select system 
data.
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To modify system data:

1. Select a PRG from the Advanced View submenu.

2. Modify the desired settings on the screen.

3. Press the Apply button to save the changes.

When programming system data, changes are applied:

 when the Apply button is pressed.

 when the you change the system data item link.

 when you modify the current system data item filter.

 when you exit Advanced View, except when the Cancel button is pressed.
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Chapter 7 Ribbon Bar and Sliding Panels

SECTION 1 GENERAL DESCRIPTION RIBBON BAR AND SLIDING PANES

Figure 7-1  Default PCPro Screen

Ribbon Bar Main work 
area

Navigation pane

Sliding pane selection
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1.1 Ribbon Bar

File  

Home  

View   

Reports  

Figure 7-2  Ribbon Bar - File

Figure 7-3  Ribbon Bar - Home

Figure 7-4  Ribbon Bar - View

Figure 7-5  Ribbon Bar - Reports
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Filter Options  

Tools  

SECTION 2 DEFAULT RIBBON BARS

Figure 7-6  Ribbon Bar - Filter Options

Figure 7-7  Ribbon Bar - Tools

Figure 7-8  Ribbon Bar - Home 
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Figure 7-9  Ribbon Bar - View

Figure 7-10  Ribbon Bar - Reports

Figure 7-11  Ribbon Bar - Filter Options
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Appendix A Communications

SECTION 1 OVERVIEW

PCPro provides methods for the application to communicate with the chassis.  PCPro 
can connect to the chassis to allow you to download/upload data, to perform a system 
initialization, to update firmware, to activate features and to backup a database to or 
restore a database from a flash key.

SECTION 2 CONNECT/DISCONNECT

Connect/Disconnect makes or breaks a connection session between PCPro and a 
chassis.  This option changes its functionality depending on the connection status of 
PCPro.  Figure A-1 Connect/Disconnect Status shows how the connection status is 
indicated on the toolbar.   

2.1 Accessing Connection Dialog

Connecting PCPro to a system is done within the Connect dialog. While 
PCPro is disconnected from a system, access the Connect dialog using one of 
the following three methods.

 Select the menu item Communications > Connect/Disconnect.

Figure A-1  Connect/Disconnect Status

Disconnected Signifies that PCPro is not connected to the chassis.

Connected Signifies that PCPro is currently connected to the chassis.

Connect/Disconnect Status
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    or…

 Select the icon depicting the disconnected black and yellow plugs .

    or…

 Press F5.

2.2 Connecting PCPro to the System

Use the Connect dialog box to specify connection parameters to connect to 
the system.  

Figure A-2  Connect Dialog

 (Optional) Load a 
defined Connection 
Account (can skip 
steps 1~3 by using 
this option.)

1)  Select 
Connection Type.

2)  To login, specify 
the User Name and 
Password.

3)  To make the 
connection to the 
system, click 
Connect.
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To make a connection between PCPro and the system:

1. Select a Connection Type and specify the settings relevant to the 
selected type.  

2. Specify the User Name and Password used to allow the connection.

3. Alternatively, steps 1~2 can be skipped loading a defined connection 
account (refer to Appendix D - Connection Accounts).

4. Press the Connect button.

After a successful connection, the connection settings that are used are 
set to the File Properties.

 With SL1100 PC Pro 3.5 or higher, after connecting PC Pro automatically downloads the 
database if there has been no changes to the new/default database.

 If one change is made to the default database the download does not happen, even if the 
change is set back.

2.2.1 Connection Types

PCPro supports two types of connections to a system. 

Connection Types for SL1100: 

 IP
An IP Connection can be made via a LAN or the Internet. The IP 
address specified should match the system setting 10-12-01. If 
connecting to the ethernet port on the VoIP daughter board, use the 
IP address setting in 10-12-09.

 Dial-up
An IP  via Dial-up can be made via a dial-up connection, either 
through ISDN or an analog modem.

 The Dial-up connection has to be up and connected before trying to 
use this connection.

To install dial up connection, refer to paragraph 2.2.2 Create SL1100 Dial
Up Connection on page A-3.

2.2.2 Create SL1100 Dial Up Connection

When connecting an SL1100 via modem, a Dial Up Connection 
(PPP) must be created.  The following steps describe how to set up 
the Dial Up Connection (PPP).

1. Click Start >Settings>Network Connections.
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2. Select Create a New Connection.  

3. Click Next.

4. Select Connect to the network at my workplace, then click 
Next.

Figure A-3  New Connection Wizard Dialog
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5. Select Dial-up connection, then click Next.  

Figure A-4  Network Connection Type Dialog

Figure A-5  Network Connection Dialog
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6. Enter a name to be used for the dial-up connection.  

7. Enter the telephone number to be dialed, then click Next.

Ensure the SL1100 programs 11-15-14, 22-02 and 22-07 are setup to 
receive calls to the modem.  

Figure A-6  Connection Name Dialog

Figure A-7  Phone Number to Dial Dialog
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8. Setup the availability of the connection, then click Next.  

9. Click Finish.       

Figure A-8  Connection Availability Dialog

Figure A-9  Completing the New Connection Dialog
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2.2.3 Login

Specify the User Name and Password that will allow the connection. 
The account must exist within the chassis settings 90-02. Like PCPro 
Accounts, Login Accounts govern what system data can be 
accessed from the chassis.

It is important to note, Login Accounts are not the same as PCPro 
Accounts. Thus both chassis Login and PCPro Account settings are 
NOT synchronized and are independent of each other.

Once connected, the PCPro access level changes to match the level 
assigned to the user name/password used to connect. This access 
level is set in 90-02 on the chassis. For example, if you start PCPro 
in Installer (IN) mode, but connect to a chassis using an account with 
an access level of System Administrator Level 1 (SA), after 
connecting PCPro assumes the access level of SA. Once you are 
disconnected, PCPro reverts back to the access level IN.

2.3 Disconnecting PCPro from the System

While PCPro is connected to a system, you can disconnect using one of the 
following methods:

1. Select the menu item Communications > Connect/Disconnect.

    or…

2. Select the icon depicting the connected black and yellow plugs .

or…

3. Press F5.

All communication methods, excluding ‘Connect/Disconnect’, are disabled 
and the ‘Connect/Disconnect’ toolbar icon changes status to disconnected.

SECTION 3 DOWNLOAD

Downloading pulls all the data off the system and loads it into PCPro. A download can 
only occur when PCPro is connected to a system.

3.1 Accessing Download

When PCPro is connected to a system, access the Download dialog using one 
of the following methods.

 Select the menu item Ribbon Item Home > Download.



NEC SL1100 Issue 3.01

PC Programming Manual A - 9

___________________________________________________________________________________

___________________________________________________________________________________

    or…

 Select the icon depicting the blue arrow .

    or…

 Press F6.

3.2 Downloading Data from the System to PCPro

Use the Download dialog to specify the parameters and perform a download. 

To download data from system memory to PCPro:

1. Select a Transfer Type.

2. Select Transfer Type items.

3. If desired, select items via the Modify Filter.

4. Press the Start button.

Figure A-10  Download Dialog

3)  Apply filter 
to help find 
items.

1)  Select 
Transfer Type.

2)  Select 
additional 
item(s) to 
download.

4) Click Start to begin 
download.

5) When completed, click 
Close.
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5. After the download is completed, press the Close button.

3.2.1 Transfer Type

Select a filter that controls the scope of settings to download. The 
following Transfer Types are made available.

 All: No filter, all chassis settings.

 Blade Configuration: Blade package settings.

 System Data Partial (System Wide): System-based settings.

 System Data Partial (Telephone): Telephone-based settings.

 System Data Partial (Virtual Extension): Virtual Extension-based 
settings.

 System Data Partial (Trunk): Trunk-based settings.

 User Data: User-specific settings.

Transfer Type Items

Specifically select PRG Groups and/or individual PRGs from the 
chassis settings to download. The choice of Transfer Type Items 
available is governed by the Transfer Type selected.

Modify Filters

A  filter is applied based on the system data modification status. The 
filter only applies to system data on the PCPro side, not system data 
residing in chassis memory.  Refer to Appendix C - Modification 
History for further information.

SECTION 4 UPLOAD

Uploading pushes all the data from PCPro to system memory. An upload can only 
occur when PCPro is connected to a system.

4.1 Accessing Upload

When PCPro is connected to a system, access the Upload dialog using one of 
the following methods:

 Select the menu item Ribbon Item Home > Upload.

    or…

 Select the icon depicting the red arrow .

    or…
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 Press F7.

4.2 Uploading Data from PCPro to System Memory

Use the Upload dialog to specify the parameters and perform an upload. 

To upload data from PCPro to system memory:

1. Select a Transfer Type.

2. Select Transfer Type items.

3. If desired, select items via the Modify Filter.

4. Press the Start button.

5. After the upload is completed, press the Close button.

Figure A-11  Upload Dialog

3)  Apply filter 
to help find 
items.

1)  Select 
Transfer Type.

2)  Select 
additional 
item(s) to 
upload.

4) Click Start to begin 
download.

5) When completed, click 
Close.
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4.2.1 Transfer Type

Select a filter that controls the scope of chassis settings to upload. 
The following Transfer Types are made available.

 All: No filter, all Chassis settings.

 Blade Configuration: Blade packages settings.

 System Data Partial (System Wide): System-based settings.

 System Data Partial (Telephone): Telephone-based settings.

 System Data Partial (Virtual Extension): Virtual Extension-based 
settings.

 System Data Partial (Trunk): Trunk-based settings.

 User Data: User-specific settings.

Transfer Type Items
Specifically select PRG Groups and/or individual PRGs from the 
chassis settings to upload. The choice of Transfer Type Items 
available is governed by the Transfer Type selected.

Modify Filters
A filter is applied based on the system data modification status. The 
filter only applies to system data on the PCPro side, not system data 
residing in chassis memory.  Refer to Appendix C - Modification 
History for further information.

4.3 Uploading Blade Configuration 

When uploading the Blade Configuration via Upload All, and selecting Card 
Configuration, or just Uploading Card Configuration, a warning popup will 
display when either Trunks or stations are busy at the time of selecting to 
uploading the Card Configuration.  This will allow for the upload to be 
cancelled and completed at a later time, or to be continued and will disconnect 
the busy trunks and/or stations. 

This popup is shown when the Card Configuration is selected to be uploaded 
and the trunks are busy. 

Figure A-12  Trunk Ports Busy Warning
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This is popup is shown when the Card Configuration is selected to be 
uploaded and stations are busy.  

SECTION 5 FEATURE ACTIVATION

Some system features are licensed and require registration before they can be used.  
Features can be activated by registering the feature automatically via the Internet or 
manually by downloading the associated Software Code.  Feature Activation can only 
occur when PCPro is connected to a system.  

5.1 Accessing Feature Activation

When PCPro is connected to a chassis, access the Feature Activation dialog 
by selecting the menu item Ribbon Item Home > Feature Activation.

Figure A-13  Station Ports Busy Warning



A - 14

___________________________________________________________________________________

___________________________________________________________________________________Issue 3.01 NEC SL1100

5.2 Activating a Feature
Refer to Appendix F - Feature Activation for a detailed discussion.

Figure A-14  Feature Activation Dialog
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SECTION 6 FIRMWARE UPDATE

Firmware Update automatically updates the main software in a system remotely at a 
scheduled time. This feature saves times and effort in comparison to performing the 
task manually.  A Firmware Update can only occur when PCPro is connected to a 
chassis.    

The time to upload the firmware package file is directly related to the file size. 
At present, the package file is about 10MB, so over LAN it may take several 
minutes.

A backup of system data should be performed before any firmware update.

Figure A-15  Firmware Update Dialog
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Before Firmware Update can be used the system must meet the following 
requirements:

1. Feature Activation
The Firmware Update feature must be registered through Feature 
Activation. Refer to Section 5 Feature Activation on page A-13 for 
details.

2. Hardware
The hardware prerequisite for Firmware Update is the Compact Flash 
drive. The Compact Flash drive is used to store the Firmware Update file 
before the operation is executed.

6.1 Accessing Firmware Update

When PCPro is connected to a chassis, access the Firmware Update dialog 
by selecting the menu item Ribbon Item Home > Upgrade SW.

6.2 Using Firmware Update

Use the Firmware dialog to specify the parameters and perform a Firmware 
Update.

To perform a firmware update:

1. Select a Firmware File.

Firmware Package File:
Select a Firmware package file provided by NEC. Updating a chassis with a 
faulty Firmware page file could render the system unusable.

2. Schedule when the Firmware Update is to occur using the parameters in 
the Schedule Update section.

Schedule:
Schedule when the Firmware update will occur. The changes of the 
Firmware Update will only occur after the chassis is reset. Thus the 
Firmware Update should be executed at a suitable time when the 
chassis is not actively in use.

 The time you specify should be relative to the time on the chassis, not the local time 
of the PC.

3. Press the Start button.
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6.3 Remote Upgrade Function by WebPro

This function is available with Version 4.0 or higher system software.

1. The user level which performs the Remote Update is as follows:

1 = MF (Manufacturer Level)

2 = IN (Installer Level)

2. You can choose “Immediately” or “At the time” as installation timing.

3. Immediately means the Update will be performed immediately after 
uploading is complete.

4. At the time means the Update will perform at a preset date and time.

5. When the start button is pressed the upload process will begin even if “At 
the time” is set.

Below is an example of remote firmware update.  

Figure A-16  Remote Firmware Update Screen

Select Firmware
Update
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Figure A-17  Firmware Update Screen

1. Browse to Firmware File.

2. Select Immediately or At the time...

3. Select Start Update.

4.  Once the firmware is loaded the system will reset immediately, or 
at the time specified.

1.

2.

3.
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SECTION 7 SYSTEM INITIALIZATION

A System Initialization resets a system. During an initialization all telephone calls are 
dropped and all connections to WebPro, PCPro and the handset are lost.  Therefore, 
it is important that initialization should be executed at a suitable time when the system 
is not actively in use.  PCPro can only execute an initialization when it is connected to 
a system. 

7.1 Accessing System Initialization

When PCPro is connected to a system, access the System Initialization dialog 
by selecting the menu item Communications > System Initialization.

7.2 2nd Initialization
A 2nd Initialization resets the chassis and retains all previously modified values 
within system data.

Figure A-18  System Initialization Dialog
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Appendix B Copy/Fill

SECTION 1 OVERVIEW COPY (ADVANCED TAB)

The system data copy function allows you to copy data from one item to another (e.g., 
one trunk to another).  This copy only applies to a single program. Copy only appears 
on screens where it is applicable.    

Figure B-1  System Data Copy

2) Specify copy source.

3) Specify copy destination.

4) Specify data to be 
copied.

5) Click OK to copy.

1) Select copy.
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SECTION 2 COPYING SYSTEM DATA (ADVANCED TAB)

To copy a system data item: 

1. Press the Copy button .

2. When the Copy dialog box is displayed, specify the source to copy from.

The source (From) shows the item being copied from. Only a single source item 
can be selected.

3. Specify elements of the source that you want to copy.

These settings are specific to the system data being copied.

4. Specify the destination where you want to the elements copied.

The destination (To) details the item(s) where the selected source information is 
copied to. Multiple destination items can be selected.

5. Press OK to copy the selected items.
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SECTION 3 OVERVIEW  COPY (STANDARD TAB)

 This feature is available on PCPro version 4.0 and higher. 

Figure B-2  Overview Copy (Standard Tab)

1) Select copy.

2) Select copy source.

3) Specify copy
     destination.

4) Specify data to be
     copied.

5) Click OK to copy.
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SECTION 4 COPYING SYSTEM DATA (STANDARD TAB)

 This feature is available on PCPro version 4.0 and higher.

To copy a system data item:

1. Press the Copy button.

2. When the Copy dialog box is displayed, specify the source to copy from. The 
source (From) shows the item being copied from. Only a single source item can 
be selected.

3. Specify elements of the source that you want to copy. These settings are 
specific to the system data being copied.

4. Specify the destination where you want the elements copied. The destination 
(To) details the item(s) where the selected source information is copied to. 
Multiple destination items can be selected.

5. Press OK to copy the selected items.
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SECTION 5 OVERVIEW FILL (MULTIASSIGN-STANDARD TAB)

 This feature is available on PCPro version 4.0 and higher.

1. Each of the sections below has a “MultiAssign” icon added to the individual
screen.

System/Numbering/Stations

System/Numbering/Virtual Extensions

System/Numbering/Department Groups

Stations/Config/InMail

2. Below is an example of the MultiAssign icon in System/Numbering/Stations.  

Figure B-3  MultiAssign in System/Numbering/Stations Screen

MultiAssign icon
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3. When the new “MultiAssign” icon is pressed in System/Numbering/Stations, a 
screen similar to the one below will be presented. Note the default ports for 
extension assignment is 1~128.  

1. Select drop down to select the Extension type.

2. Assign the beginning port number.

3. Assign the ending port number.

4. Assign the first Extension in the range.

5. Click Apply.

Figure B-4  MultiAssign - Extension Numbers Example

1) Drop down to select extension type2) Beginning station port

3) Ending station port

4) The first station number 5)Click Apply
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4. When the MultiAssign icon is pressed from System/Numbering/Virtual 
Extension the following screen will be presented. Note the default ports for 
Virtual extension assignment is 1-50. All other assignments are the similar to 
extension numbering. 

5. When the MultiAssign icon is pressed from System/Numbering/Department 
Groups the following screen will be presented. Note the default ports for 
Department Group Pilot numbers are 1-32. All other assignments are the similar 
to extension numbering. 

Figure B-5  MultiAssign -  Virtual Extension Numbers

Default
Ports

Figure B-6  MultiAssign -  Department Group Pilot Numbers

Default
Ports
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6. When the MultiAssign icon is pressed from Stations/Config/InMail the following 
screen will be presented. Note the default ports for InMail is 1-128. All other 
assignments are the similar to extension numbering.   

7. When a user is not in the Standards Tab they will be able to use range 
programming by clicking on the MutliAssign tab on the toolbar in PCPro. Below 
is an example of where this is on the “Home” toolbar. Select the drop down 
arrow and you will see Account codes, DID and Extension number.   

Figure B-7  MultiAssign -  InMail Station Mailbox Options

Default
Ports

Figure B-8  MultiAssign Tab
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8. This new MultiAssign function has the ability to MultiAssign the following items 
using a drop down selection box:

 Account codes

 Direct Inward Dial (DID)

 Extension numbering

An example of the account code box is below:  

An example of the Direct Inward Dial is below:   

Figure B-9  MultiAssign - Account Code

Beginning 
Account 
Code Bin

Ending 
Account 
Code Bin

First  
Account 
Code 

Increment  
Account 
Code 

Click Apply

Figure B-10  MultiAssign - Direct Inward Dialing (DID)

Beginning 
DID

Number of 
DIDs

Use 
Received 
Number

Use Target 
Number

Click Apply
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9. Below is an example of the extension number drop down, all other settings are 
the same as the Extension Numbers in the first section.   

Figure B-11  MultiAssign -  Extension Number Type Example

Select 
Extension 
Type
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Appendix C Modification History

SECTION 1 OVERVIEW

PCPro keeps a record of all the modifications made to a database file. This record is 
known as the Modification History.  PCPro also provides you with the ability to view 
this history list. Following is the list of database operations that PCPro records in the 
modification history.   

Operation Details

System Data Set This includes programming performed through:

 Standard View Screens

 Wizards

 System Data Programming

 Copy

For each set, an entry is made to the history list. The entry records the 
following items:   

Field Data

Date Date and time of operation.

User Name The User Name that performed the operation.

Display Name The Display Name that performed the operation.

Access Level The Access Level that performed the operation.

Type Identifies the operation type.  Set to “Set Date”.

Modification The system data ID.

Details

The item changed.

Old value.

New value.



C - 2

___________________________________________________________________________________

___________________________________________________________________________________Issue 3.01 NEC SL1100

The modification history is only saved in the local database when you perform File 
Save or File Save As. The modification history is a running list of the changes. PCPro 
keeps appending to the list. If you open a file, make changes, save and close the file 
and in the future open the same file and make additional changes, then the new 
modification history is appended to the old.

The modification state of a PCPro database is indicated via the modification icon on 
the Status Bar. The different filters are:    

SECTION 2 ACCESSING MODIFICATION HISTORY

To access Modification History, complete one of the following:

 Select the menu item Ribbon Item > Reports > Modification History.

               or…

 Select the clock icon on the toolbar .

SECTION 3 GENERATING A MODIFICATION HISTORY REPORT

A Modification History Report can be viewed in either HTML format or Comma 
Separated Variable (CSV) format. Sample formats are shown in Figure C-2 Sample 
Modification History HTML Format on page C-3 and Figure C-3 Sample Modification 
History CSV Format on page C-4. 

To request a report:

1. Access the report by selecting Modification History from the toolbar or by 
clicking the clock icon (refer to Section 2 Accessing Modification History).

2. When the Export Modification History dialog box is displayed, click either the 
HTML or CSV option and press OK. 

The database is not modified. All data has been saved to file and uploaded.

System data has been modified and has not been saved to file.

System data has been saved to file but has not been uploaded.

System data has been modified and has not been saved to file nor uploaded.
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3. The report is generated in the format you selected.  (Refer to Figure C-2 Sample 
Modification History HTML Format and Figure C-3 Sample Modification History 
CSV Format on page C-4).

   

Figure C-1  Export Modification History Dialog Box

Figure C-2  Sample Modification History HTML Format
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Figure C-3  Sample Modification History CSV Format
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Appendix D Connection Accounts

SECTION 1 OVERVIEW

Connection Accounts provide a convenient way of loading user defined connection 
settings. These are application wide settings.  Connection Accounts can be created in 
two ways:

 Via the Connect dialog

 Via the Connection Accounts dialog

SECTION 2 CREATING/DELETING A CONNECTION ACCOUNT USING THE CONNECT 
DIALOG

This section describes how to use the Connect dialog to create a new Connection 
Account or delete an existing Connection Account.  (Refer to Figure D-1 Connect 
DialogCreating/Deleting Connection Account on page D-2.)
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2.1 Creating a New Account

To create an account using Connect dialog:

1. Select a Connection Type and specify settings relevant to the 
Connection Type.

2. Specify the Login User Name and Password used to allow the 
connection.

3. Press the Save or Save As button located in the Connection Account 
section of the dialog.  

4. When the Save As dialog is displayed, enter a description of the 
connection (refer to Figure D-2 Save As Connection Account Dialog on 
page D-3.)

Figure D-1  Connect DialogCreating/Deleting Connection Account

Click Save or Save As to 
create a Connection 
Account.

Select the 
Connection Type. 

Specify the Login User 
Name and Password.

Select a Connection 
Account from the pulldown 
menu and click Delete a 
Connection Account.
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5. Press OK to save the Connection Account.

2.2 Deleting an Account

An existing Connection Account can be deleted.  

To delete an existing account:

1. Select the Connection Account from the pulldown menu on the 
Connect dialog.  (Refer to Figure D-1 Connect DialogCreating/Deleting 
Connection Account on page D-2.)

2. Click the Delete button.  

Figure D-2  Save As Connection Account Dialog

Enter the Connection 
Account description.

Click OK to save the 
Connection Account.
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SECTION 3 CREATING/MODIFYING/DELETING A CONNECTION ACCOUNT USING THE 
CONNECTION ACCOUNTS DIALOG

This section describes how to create, modify or delete a Connection Account using 
the Connection Accounts dialog.

To access the Connection Accounts dialog, select Tools > Connection Accounts on 
the toolbar.  

3.1 Creating a New Account

To create a new Connection Account:

1. Click the Add button.

2. When the Connection Account Settings dialog is displayed, enter the 
account properties.

3. Click OK to save the Connection Account.

Figure D-3  Connection Account DialogCreating/Modifying/Deleting Connection Account

Click Add to create 
a new Connection 
Account.

Settings
Dialog

Select a Connection 
Account and click 
Remove to delete an 
account.

When adding a new Connection Account, 
click the tabs to set the appropriate values 
and click OK.

Click Properties to 
modify the setting of 
an existing account.
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3.2 Modifying an Existing Account

To modify an existing Connection Account:

1. Select the Connection Account on the Connection Accounts dialog.

2. Click the Properties button.

3. When the Connection Account Settings dialog is displayed, change the 
settings of the selected account.

4. Click OK to save the changes to the account.

3.3 Deleting and Existing Account

To delete an existing Connection Account:

1. Select the Connection Account on the Connection Accounts dialog.

2. Click Remove to delete the selected account.
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Appendix E Debug Terminal 

SECTION 1 OVERVIEW

PCPro provides a debug terminal that can be used to capture trace logs from the 
CPU-B1 in the chassis. The debug terminal communicates with the chassis via the 
LAN.  A TCP connection on port 5963 is established between the debug terminal and 
the chassis.   

Figure E-1  Debug Terminal Dialogs

1) Specify 
connection 
information.

2) Specify the 
log file to be 
used for data 
capture.
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SECTION 2 LAUNCHING THE DEBUG TERMINAL

You can launch the debug terminal in one of two ways:

 Select the menu item Ribbon item Home > Debug Terminal.

    or…

 Click on the DbgTerm icon on the toolbar  .

   

If PCPro is connected via LAN to a chassis, then the debug terminal automatically 
tries to connect to the same IP address (domain name).  Once the debug terminal is 
running, incoming debug messages from the chassis appear on the screen.  You can 
capture the incoming data to a file by specifying a log file name and enabling the log 
capture.

Log capture can be enabled or disabled at the your discretion. A message is printed in 
the log file indicating the date and time the capture was enabled or disabled.
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Appendix F Feature Activation

SECTION 1 INTRODUCTION

There are three methods for activation of features on the CPU-B1: automatic 
activation via PCPro, manual activation via PCPro and manual activation via WebPro. 

SECTION 2 FEATURE ACTIVATION USING PCPRO

Some system features require registration before they can be used.  Feature 
Activation registers these features automatically via the Internet or manually through 
input of Activation Codes.  Feature Activation can only occur when PCPro is 
connected to a system.   

Figure F-1  PCPro Feature Activation Dialog

Hardware Key (number assigned 
by NEC and printed on equipment).

Informational area that lists features available for activation.  For each feature, 
the quantity registered, the activation status (On = activated, Off = not activated) and 

an expiration date for feature activation (if assigned) is displayed.

 Registration Request html report 
for license.

Exit Feature 
Activation.
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2.1 Accessing Feature Activation

When PCPro is connected to a chassis, access the Feature Activation dialog 
by selecting the menu item Ribbon item Home > Feature Activation.

2.2 Activating a Feature

The license file contains the Software Code, which is required to activate the 
feature.

To activate a feature manually:

1. Launch PCPro and access Feature Activation (refer to 2.1 Accessing 
Feature Activation).

2. If connected to the SL1100 system, the Hardware Code is retrieved and  
displayed.  

3. Click Load File (refer to Figure F-2 Feature Activation Open File Dialog 
on page F-3). 

 This file can reside on the PC or you can copy it to a  flash drive to 
reference if activating other locations.
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4. When you have located the file (xxxxxxx.lic), select it and click Open.

5. When the confirmation dialog is returned, click Save & upload now to 
immediately save the file on the ProPro database and activate the 
feature (refer to Figure F-2 Feature Activation Open File Dialog).

Figure F-2  Feature Activation Open File Dialog
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SECTION 3 FEATURE ACTIVATION USING WEBPRO

WebPro can also be used to manually activate features.

3.1 Manually Activating a Feature

To activate a feature using WebPro, you must have Internet connection.

1. Point your browser at the IP address of the CPU-B1 (set in PRG 
10-12-01).

2. When the Home page is displayed, enter the User Name and 
Password.

The default User Name = sltech and Password = 12345678. 

3. If login was successful, the WebPro Home page is displayed.  Click 
Feature Activation.   

Figure F-3  WebPro Login Screen
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4. The WebPro License Registration dialog is displayed.  

Figure F-4  Feature Activation Screen WebPro Home Page

Figure F-5  Feature Activation Screen WebPro Manual Activation
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5. If connected to the SL1100 system, the Hardware Code is retrieved and  
displayed.  

6. In the Upload a license file to the KTS field, click Browse to locate the 
license file (XXXXXXX.lic). 

 This file can reside on the PC or you can copy it to a flash drive to reference 
if activating other locations.).

7. When the Open dialog is displayed, select the license file and click 
Open.  When prompted to proceed, click Yes.

 

8. Click Upload to retrieve the license file.

Figure F-6  Feature Activation Open File Dialog WebPro



PC Programming Manual G - 1

___________________________________________________________________________________

Appendix G DIM File Download

SECTION 1 OVERVIEW

The DIM File Download feature supports downloading a DIM log file using PCPro. A 
DIM log file contains operational, system information, and critical information about 
the system.

SECTION 2 OPERATION

Use the following procedure to download a DIM log file using PCPro.

1. From the PCPro toolbar, select Tools> DIM File Download.  A DIM File 
Download dialog box appears, Figure G-1 - DIM File Download. 

 The DIM File Download menu is only available when PCPro is connected to the system.

Figure G-1  DIM File Download
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When the Download Dialogue runs, PCPro requests file information from 
"C:\\DATA\\*.txt"".  The Dialog Box displays all existing files with  
"C:\\DATA\\*.txt"".  

2. Check the Download box next to the file(s) to download from the 
system.

3. Click OK.  PCPro begins downloading the selected file(s) from the 
system.  A status line on the bottom indicates which file is being 
downloaded at that moment.  Refer to Figure G-3 - DIM File Download 
Status.

Figure G-2  DIM File Download Dialog Box
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 Limitation: "The maximum file size that it is available to download with PCPro is 1MB 
per file.  If the file is 1.5MB the first 1MB will download fine but the last 500 KB will not 
download.

Figure G-3  DIM File Download Status
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Chapter H End User Programming

SECTION 1 END USER PROGRAMMING

WebPro has an End User Login for which extensions can program functions for their 
own extension. End Users can use End User Programming to program:

 Function keys

 Virtual Extension ringing assignment

 Station Speed Dial

 InMail features

 Station Name

 Call Forwarding

 Display Language

 Ring Tone

 End User Password
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To login to the WebPro End User Programming, input the system IP (default: 
192.168.0.10) or NetBIOS Address (default: http://SL1100) like you would logging into 
WebPro. Use the extension number as User Name and Password is assigned in PRG 
90-28-01 (default: 1111).  

Figure H-1  End User Programming Login Screen
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Once logged in, the user can navigate between the program options at the top to 
configure different options for their extension.  

Figure H-2  End User Programming - Telephone Setting
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